Memorex:

Is it live or is it Memorex?™

MMP8550
User’s Guide

256 MB MP3/WMA
Digital Audio Player

Before operating this product,

please read these instructions completely.



PRECAUTIONS

COPYRIGHT:
» Distributing copies of MP3, WMA with DRM or WAV tracks without permission is a
violation of international copyright laws.

SAFETY:

» Vibration experienced during walking or exercising will not affect the player. However,
dropping the player or dropping a heavy object on the player may result in damage or
sound distortion.

»  Avoid spilling any liquid onto or into the player.

» Do not leave the player in a location near heat sources; in a location subject to direct
sunlight, excessive dust, sand, moisture, rain or mechanical shock; on an unlevel
surface; or in a car with the windows closed during periods of excessive heat.

ROAD SAFETY:

* Do not use headphones while driving, cycling or operating any motorized vehicle. It
may create a traffic hazard and it is illegal in some areas. It can be potentially
dangerous to play your headset at a high volume while walking, especially at pedestrian
crossings. You should exercise extreme caution or discontinue use in potentially
hazardous situations.

FCC WARNING:

* This equipment may generate or use radio frequency energy. Changes or
modifications to this equipment may cause harmful interference unless the
modifications are expressly approved in the instruction manual. The user could lose
the authority to operate this equipment if an unauthorized change or modification is
made.

This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme a la norme NMB-003
du Canada.




FCC DECLARATION

This device complies with Part 15 of the FCC rules. Operation is subject to the
following two conditions: 1) This device may not cause interference, and 2) This
device must accept any interference received, including interference that may cause
undesired operation.

Warning: Changes or modifications to this unit not expressly approved by the party
responsible for compliance could void the user’s authority to operate the equipment.

NOTE: This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

» Reorient or relocate the receiving antenna.

« Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

« Consult the dealer or an experienced radio/TV technician for help.

Shield cable must be used with this unit to ensure

compliance with class B FCC limits. Tested To Comply
C With FCC Standards
FOR HOME OR OFFICE USE




Dear Customer:

Selecting fine audio equipment such as the unit you've just purchased is only the start
of your musical enjoyment. Now it’s time to consider how you can maximize the fun
and excitement your equipment offers. This manufacturer and the Electronic Industries
Association’s Consumer Electronics Group want you to get the most out of your
equipment by playing it at a safe level. One that lets the sound come through loud and
clear without annoying blaring or distortion and, most importantly, without affecting
your sensitive hearing.

Sound can be deceiving. Over time your hearing “comfort level” adapts to higher
volumes of sound. So what sounds “normal” can actually be loud and harmful to your
hearing. Guard against this by setting your equipment at a safe level BEFORE your
hearing adapts.

To establish a safe level:

« Start your volume control at a low setting.

» Slowly increase the sound until you can hear it comfortably and clearly, and without
distortion.

Once you have established a comfortable sound level:
» Set the dial and leave it there.

Taking a minute to do this now will help to prevent hearing damage or loss in the future.
After all, we want you listening for a lifetime.

We Want You Listening For A Lifetime

Used wisely, your new sound equipment will provide a lifetime of fun and enjoyment.
Since hearing damage from loud noise is often undetectable until it is too late, this
manufacturer and the Electronic Industries Association’s Consumer Electronics Group
recommend you avoid prolonged exposure to excessive noise. This list of sound levels
is included for your protection.



Decibel
Level
30
40

Example

Quiet library, soft whispers

Living room, refrigerator, bedroom away from traffic

Light traffic, normal conversation, quiet office

Air conditioner at 20 feet, sewing machine

Vacuum cleaner, hair dryer, noisy restaurant

Average city traffic, garbage disposals, alarm clock at two feet

THE FOLLOWING NOISES CAN BE DANGEROUS UNDER CONSTANT EXPOSURE:

90
100
120
140
180

Subway, motorcycle, truck traffic, lawn mower
Garbage truck, chain saw, pneumatic drill

Rock band concert in front of speakers, thunderclap
Gunshot blast, jet engine

Rocket launching pad

Information courtesy of the Deafness Research Foundation.




LOCATION OF CONTROLS

1

1. Headphone Jack 8. LOCK Switch
2. Skip/Search 44 /W Buttons 9. Reset Button (Inside the
3. Function (OFF/ON/MIX) Recess Hole)

Switch 10. LED (Function) Indicator

4. PLAY/PAUSE » 1l Button
(Reverse Side of Unit)
USB Port

VOLUME +/- Buttons
Strap Hole (For neck/hand
strap; strap is not included)

No o



POWER SOURCE

RECHARGEABLE BATTERY OPERATION

This player has a built-in Lithium Polymer rechargeable battery. It is

recommended that the battery be fully charged before using for the first time

and when the battery is low (when low, the LED indicator will blink red slowly).

In these cases, charge/recharge the battery as follows:

1. Connect your player to the USB port on your computer using the USB
cable as shown. Then the battery will charge automatically. The LED
indicator will light red when charging and will light green when fully
charged.

DE

Computer
USB cable

NOTES:

» It takes approx. three hours to charge the battery from empty to full. When
fully charged, the unit can playback for approx. 12 hours.

* When charging the battery, you can only use your computer to transfer files
to the player; the player’s other functions will be unavailable.



INSTALL “DIGITAL AUDIO PLAYER” SOFTWARE

TO INSTALL THE "DIGITAL AUDIO PLAYER" CD SOFTWARE

For Windows ME, Windows2000 or Windows XP:
Windows will automatically detect the audio player without installing the CD software
when the USB cable is connected.

For Macintosh OSX:
Macintosh OSX will automatically detect the audio player without installing the CD
software. Do not install the software when using a Macintosh.

For Windows98SE:

The USB mass storage function will not be activated without driver installation. To
activate the USB mass storage function, please use the installation CD-Rom to install
the driver.

For Windows 98SE, if you are connecting your player to your computer for the first
time, please follow these instructions:

Procedure to Install Player Driver [& -
1. Insert the Installation CD-Rom
into the CD Drive, then the
installation screen will appear. If OIS0
the installation screen doesn't
automatically appear, double-

Wincows Ml Player 10

click my computer then double- Vst

click on the CD drive, then the

installation screen will appear. v ae § ==

Click on the Windows 98

firmware icon. Then click on the Memorex

MMP8550 icon.




2. At the Welcome screen, click NEXT.

3.

4.

WS 98 DRIVER IN

oo

Read the License Agreement. If you accept g s T
the terms of the License Agreement, select e e o
and dot the circle at the left of "l accept the
terms of the license agreement". Then click
NEXT.

Bubbles Setup
Choos

At the Setup screen, click NEXT. It is
recommended to leave the destination folder
as itis.




WINDOWS 98 DRIVER INSTALLATION (CONTINUED)

5. At the Program Folder screen, click NEXT. It prem
is recommended to leave the program folder
as itis.

6. Click "Install" to start the installation.

7. When finished, the InstallShield Wizard bl setn
Complete screen will appear. Click FINISH to
exit the Install program and complete the
Windows 98 Driver installation.

]




WINDOWS MEDIA PLAYER 10 INSTALLATION

Windows Media Player 10 is for use with
Windows XP only. For Windows ME and
Windows 2000, please install Windows Media
Player 9. For Windows 98SE, please visit
www.Microsoft.com to download the
corresponding Windows Media Player for your
computer.

Once you have installed Windows Media

Player 10, you can transfer MP3 files, WMA

files, WMA files with DRM 9 or DRM 10 to your

player using the “Sync” function.

1. Insert the Installation CD-Rom into the CD
Drive, then the installation screen will
appear. If the installation screen doesn’t
automatically appear, double-click “My
Computer” then double-click on the CD
drive, then the installation screen will
appear. Click on the Windows Media
Player 10 Setup icon.

2. Installation will begin.

3. Read the License Agreement, then click |
ACCEPT.
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© Windows Media Player 10

c, Thank you for choosing Windows Media Player 10

SUPPLEVENTAL END USER LICENSE AGREEVENT

[
=2 SOFTWARE UPDATE FOR NICROSOFT WINDOWS CLIENT GPERATING SYSTEN
Sor

WINDOWS VEDIA PLAYER 10

PLERSE RAD TS SAPENENTAL O U ACRETENT (SUENETAL
EU) CIRERLLY, B ISTALING OR UG T SO WA AT ACconpa

AGRE o The e OF T SUpsheTat 7}
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WINDOWS MEDIA PLAYER 10 INSTALLATION (CONT.)

© Windows Media Player 10
. . . Installing..
4. Installation will continue.

© Windows Media Player 10

Welcome to Windows Media Player 10

5. At the Welcome screen, click NEXT.

6. Select the desired privacy options.
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WIND

7. Click on Privacy Statement to view the

Statement, if desired. When finished, click
Next.

8. Read the instructions and tick the check
boxes as desired. Then click on More
Options and tick the check boxes as desired.

Click “Finish” to finish the installation of the
Windows Media Player 10.
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DOWNLOADING AND TRANSFERRING FILES

TRANSFERRING FILES

You can download digital music files from the Internet or use encoding software to convert

music that you have on an audio CD into MP3 or WMA format. Once these files are stored

on your computer you can easily copy them to your player.

For Windows XP, if you already installed Windows Media Player 10, you can transfer

music files (MP3, WMA, WMA files with DRM 9 or DRM 10) to the player through the

"Sync" function of Windows Media Player 10. Connect your computer to the USB port on

your computer using the USB cable. "MPT Player" or "MMP8550" will appear in your "My

Computer" folder which indicates the player is connected. Then, follow the procedure on

page 16 to transfer music files to the player.

For Windows ME, Windows 2000, Windows 98 or Windows XP (without Windows

Media Player 10), transfer music files as follows:

1. Connect your player to the USB port on your computer using the USB cable as shown
on page 6.

2. A "Removable Disk" window will automatically pop-up on your computer screen.

3. To add more files and songs to your player, simply drag and drop MP3 or WMA files
from anywhere on your computer into the "Removable Disk" window.

IMPORTANT: A WMA file with DRM 9 or DRM 10 will not play back if you directly drag and

drop it into the "Removable Disk" window. You must use Windows Media Player 10 to

transfer copy-protected files as described on page 16.

13



DOWNLOADING AND TRANSFERRING FILES (CONT.)

TRANSFERRING AUDIO FILES TO YOUR DIGITAL AUDIO PLAYER USING A
MACINTOSH COMPUTER

Make sure to use a Macintosh computer with an operating system of 10.0 or layer to
transfer audio files.

1. Turn on your computer.

2. Turn on your digital audio player.

3. Connect the smaller end of the cable to the USB jack on the player and the larger
end of the cable to the USB port on your Macintosh.

4. Your computer will automatically recognize your player and mount a hard disk icon
onto your desktop.

5. Locate the folder where your audio files are stored on your computer’s hard drive.
Simply drag and drop the audio files onto the mounted hard disk drive icon of your
digital audio player located on your desktop.

6. After you have finished your transfer, put away the digital audio player hard disk
icon(s) by dragging it to the Trash icon or Control-click its icon and choose Eject from
the File menu or select Eject from the File drop-down menu located at the top of your
screen. You can also use the keyboard shortcuts by selecting the digital audio player
hard disk icon and pressing the Command-E keys.

7. Your player is ready to play the files you transferred.

14



DOWNLOADING AND TRANSFERRING FILES (CONT.)

For Windows XP, you can also utilize the previously
installed Windows Media Player 10 software to
convert music on an audio CD into MP3 or WMA
format as follows:

1. Open the Windows Media Player 10 Browser,
then click on the “Rip” icon on the top tool bar.
Insert a Music CD into the CD-Rom drive of your
computer.

NOTE: For Windows 98SE, Windows ME and

Windows 2000, please use the Windows Media

Player 9 to convert music on an audio CD into MP3 or

WMA format.

2. Click on the “Tools” menu option at the top menu bar,
then click on “Options”; the Option setting menu will
appear. Click on Rip Music and set the Rip Music to the A ey
desired location on your computer. Then, set the desired s
format for the newly ripped music (MP3 format or
Windows Media Audio format). Adjust the audio quality as
desired. When finished, click “OK” to confirm the settings.

ed and change rip settings.

Best
Quaity

3. Click on the “Rip Music” icon to start ripping the music to
your computer.

Uses about 28 B per CD (64 Kbps).

4. When the music tracks are ripped; connect the player to
your computer. Open the “MPT Player” or “MMP8550”
window and open the ripped music location window.

5. To add the transferred/ripped music files/songs to your player simply drag and drop the MP3
and/or WMA files into the “MPT Player” or “MMP8550” window.

6. When the files are finished loading into the player, follow the “Safely Remove
Hardware” procedure as shown on page 17.

15



DOWNLOADING AND TRANSFERRING FILES (CONT.)

TRANSFERRING MP3/WMA FILES AND WMA
FILES WITH DRM 9 OR DRM 10 USING THE
WINDOWS MEDIA PLAYER 10 (FOR WINDOWS
XP ONLY)
To transfer MP3 files/WMA files/WMA files with DRM
9 or 10 to the player, follow the procedure described
below using the previously installed Windows Media
Player 10. Before beginning the procedure please
turn the unit on and connect the unit to the computer
as previously described.
1. Open the “Windows Media Player Browser 10”
and click on “Sync”.

2. Click on the “Sync List” pull-down menu to
locate the music files you wish to download.
Then make sure to tick the box next to the files.

3. Select the Portable Device (MPT player or
MMP8550) that you want to copy to from the
right side drop-down menu. Click “Start Sync” to
start transferring music files to the player.

4.  After finished transferring all the desired files to  (mace o S

your unit, follow the “Safely Remove Hardware” —
procedure on the next page. o el g
NOTES:

*  For WMA files with DRM 10, you can only use
Windows Media Player 10 to transfer files to
your player.

. For Windows ME and Windows 2000, please
use Windows Media Player 9 to transfer WMA
files with DRM 9 to the player. For Windows
98SE, please visit www.Microsoft.com to
download the corresponding Windows Media
Player to transfer music files to the player.

16



SAFELY REMOVE HARDWARE

SAFELY REMOVING YOUR PLAYER FROM THE COMPUTER
NOTE: To avoid damage to your player or data loss, always follow the procedure listed below
before disconnecting your player from the USB port on your computer.

Using your mouse, double click the "Safely Remove —
Hardware" icon on the task bar.

o [ EeBYSE
From the "Safely Remove Hardware" window, select "USB
Mass Storage Device" and click the "Stop" button. The 'Safely Remove Hardware' icon
"Stop a Hardware Device" window will pop-up as shown:

@l

o ant o unphg o et and e cick 5o, Whan
1 s sfe 1.0 50 urphg e device Fom o

s
@ USE s Scage Dovioo

US8 Mase Strage Devic 2 <USB FRODUCT>

[roperes ) [ 5)

7] Diply v camperts

o [ coon

Click "OK". When the "Safe to Remove Hardware" window is displayed, you may remove the
player from the USB cable or remove the USB cable from the computer.

NOTES:

If the “Safely Remove Hardware” icon is not displayed on the task bar, please double click
on My Computer. Right click on “Removable Disk” and left click on “Eject”. Then it is safe to
remove the player from the computer.

The “Safely Remove Hardware” procedure is not necessary for Win98 and Win98SE users.
If you are using Windows XP and the Windows Media Player 10 software is already installed,
then you do not need to follow the above “Safely Remove Hardware” procedure.
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OPERATION

TURNING THE POWER ON/OFF LOCK SWITCH

Turn the unit on by sliding the Function switch to the | | Slide the LOCK switch to the LOCK position
ON position; the LED indicator will light green forafew | | t5 |ock the buttons. This is useful when you
seconds, then it will blink green and the unit will be in : :

the Pause mode. Slide the Function switch to MIX do no_t want the file c_hanged by aCCId?nta”y
(Random) position (to randomly playback the music | | Pressing a button. Slide the LOCK switch to
files). To turn the unit off, slide the Function switch to | | the opposite position (unlock) to cancel the
the OFF position; the LED indicator will turn off. Lock function.

NOTE:
. Make sure the LOCK switch is in the Unlock position (not in the LOCK position);
otherwise, when you slide the Function switch to the ON or MIX position, the unit will

not turn on.
LED (FUNCTION) INDICATOR
During Playback Light on green
Pause Flashing green
Battery Low Flashing red
Press the Volume +/- Buttons Flash once green
Skip Track/File Flash once green
High-Speed Music Search Flash repeatedly green
Charging the Battery (connected to computer) Light on red
Fully Charged (connected to computer) Light on green
No Files in the Player Red and green light flashing intervals

18



OPERATION (CONTINUED

TO LISTEN TO MP3s/WMAs/WAVs

Turn the unit on by sliding the Function switch
to the ON position; the LED indicator will light
green for a few seconds, then it will blink green
and the unit will be in the Pause mode. If you
want to playback the music files randomly,
slide the Function switch to the MIX (Random)
position.

Press the PLAY/PAUSE » Il button to start
playback. If the Function switch is set to MIX, the
unit will randomly play the files on the player. If the
Function switch is set to the ON position, the unit
will start playback on the first file OR on the last file
played before it was turned off.

Press the VOLUME +/- buttons to increase or
decrease the volume.

To stop playback and turn the unit off, slide the
Function switch to the OFF position.

NOTE:

* See pages 7 through 16 for information on

uploading MP3, WMA and WAV files to this unit.

NOTES:

. (AUTO RESUME): Each time you turn off the unit, when the unit is turned back on, this unit will
resume at the beginning of the last track which was playing before turning off.

(AUTO POWER OFF): When all the music files have been played, the unit will pause playback and

the LED (Function) indicator will flash green. After two minutes, the unit will turn off automatically and
the LED (Function) indicator will turn off. To turn on the unit again, slide the Function switch to the OFF
position and wait for a few seconds. Then slide the Function switch to the ON or MIX position; the

LED (Function) indicator will flash green again.

19



OPERATION (CONTINUED)

TO PAUSE PLAYBACK

During playback, if you wish to pause the
file momentarily, press the PLAY/PAUSE
» 1l button; playback will pause and the
LED indicator will blink green.

Press the PLAY/PAUSE » 11 button again to
resume playback; the sound will return and
the LED indicator will light green.

FORWARD/REVERSE SKIP

During playback, press the Skip/Search M
button to advance the player to the
beginning of the next file. Press the
Skip/Search W button repeatedly to
advance the player to higher-numbered
files.

During playback, press the Skip/Search 4
button to move the player back to the
beginning of the currently playing file. Press
the Skip/Search K{ button repeatedly to
move the player back to lower-numbered
files.

20



OPERATION (CONTINUED)

HIGH-SPEED MUSIC SEARCH

During playback, press and hold the
Skip/Search 44 @ or W @ button to move the
player forward or backward within a file to
locate a specific musical passage. The
player will move forward or backward at
high speed as long as the button is held.
When you release the button, normal
playback will resume.

21



TROUBLESHOOTING GUIDE

If you experience a problem with this unit, check the chart below before calling for service.

inserted.

SYMPTOM CAUSE SOLUTION
Unit will not Battery is low/empty. Recharge battery as
turn on. described on page 6.
Power is not turned Slide the Function switch to
on. ON or MIX position.
No sound. Headphones are not Insert headphones.

Volume is set too
low.

Raise the volume using the
Volume + button.

The MP3 or WMA files
are corrupted.

Download uncorrupted
files.

No files are in the
player.

Upload files to the unit as
described on pages 13-16.

The computer is not
recognizing the
player.

The player is
not securely connected.

Make sure player is
securely connected.

Win98 Driver isn't installed
or computer is not
compatible.

Install Win98 driver and/or see
pages 7-12 for
compatibility.

WMA files with DRM
can’t playback.

Incorrect downloading
methods.

See page 16 to download
WMA files with DRM.
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TROUBLESHOOTING GUIDE (CONTINUED)

SYMPTOM CAUSE SOLUTION
No buttons work. The Lock feature is Deactivate Lock feature as
activated. described on page 18.

Unit needs to be reset |Reset unit and/or

or firmware needs to be|update firmware, see
updated. pages 24-25.

Unit acting erratically. | Unit needs to be reset |Reset unit and/or

or firmware needs to be|update firmware, see
updated. pages 24-25.
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FORMATTING THE PLAYER

Formatting the Player
WARNING! Do not format this player unless it stops working and you are
instructed to do so by technical support personnel.

1. Use the USB cable to connect the
player and the computer.

2. Double click on My Computer, then )
right click "MPT Player", "MMP8565" ;
or "Removable Disk" and left click on e
"Format". Dl rams

3a. For "MPT Player" or "MMP8550", at
the "Format" window, click OK to
confirm and the player will start to
format (see figure to the right). When
finished, click "OK" to close the
Format window.

3b. For "Removable Disk", at the "Format" window, select "FAT 32" from the
file system pull-down menu, then click "Start" to format the unit (see
figure above).
NOTE: Make sure you have selected "FAT 32" at the file system pull-
down menu; otherwise, after formatting, the player will not work properly.
Then, click OK to confirm and the player will start to format. When
finished, click "Close" to close the Format window.

Format window for
"MPT Player" or
"MMP8550"
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UPDATING THE FIRMWARE

WARNING! Do not update the firmware unless you are experiencing problems with
your digital audio device. Incorrect or faulty firmware installation will cause the player
to stop functioning.

1. Download the updated firmware at www.memorexelectronics.com.

2. Unzip the file, then double click setup.exe in the Desktop folder to install the
software to your computer.

3. Connect the player to the computer using the supplied USB cable and the
installation screen will appear. (If the installation screen does not appear, unplug
the USB cable and turn off the unit). Connect to the computer again and press and
hold the Power On/Off/Stop button until the installation screen appears.

4. Follow the on-screen instructions to install the driver.

5. When finished, click START and locate the newly installed software “Bubbles” and
select “Firmware Download”.

RESETTING THE UNIT

If the unit acts erratically, reset the unit by inserting a thin object (such as a paper clip)
into the recessed RESET button. For the RESET button, see page 5 for the button's
location.



SPECIFICATIONS

Audio Frequency Range 20Hz—20KHz
Headphones Output 5mW, 32ohm (Max. Vol)
S/N Ratio 85db (MP3)
File Support MP3 MPEG 1/2/2.5 Layer 3
WMA Windows Media Audio (WMA file with
DRM 9 or DRM 10)
Bit Rate 32kbps—320kbps (MP3)
32kbps—192kbps (WMA)
General Dimension 2.3 inches (diameter) x 0.63 inches
(thickness)
Weight 1 ounce
usB USB 2.0
Built-in Memory 256MB
Max. Playtime Approx. 12 hours
Supported OS Win ME, 2000, XP and Mac OSX

Win 98SE (Driver is required)
Operating Temperature  23° F to 104° F (-5° C to 40° C)
Rechargeable Battery Li-Polymer Rechargeable Battery
DC 3.7V, 280mAh

Specifications are subject to change without notice.
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FOR FIRMWARE UPGRADE, PLEASE VISIT OUR WEBSITE AT
WWW.MEMOREXELECTRONICS.COM
TO CHECK IF THERE IS NEW FIRMWARE AVAILABLE.

FOR ADDITIONAL SET-UP OR OPERATING ASSISTANCE,
PLEASE VISIT OUR WEBSITE AT

WWW.MEMOREXELECTRONICS.COM
OR CONTACT CUSTOMER SERVICE AT (954) 660-7100.

PLEASE KEEP ALL PACKAGING MATERIAL FOR AT LEAST 90
DAYS IN CASE YOU NEED TO RETURN THIS PRODUCT TO YOUR
PLACE OF PURCHASE OR TO MEMOREX.

FOR PARTS AND ACCESSORIES, CONTACT FOX INTERNATIONAL
AT 1-800-321-6993.
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Memcorp, Inc.
Weston, FL
Printed in China

Visit our website at www.memorexelectronics.com



